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Fund Management processing allows colleges to use the Fund Management 

processing for their reconciliation efforts. 

 

Fund Roster – A report used for reconciliation displaying students’ financial aid 

item types amounts that are offered, accepted, authorized, and disbursed, 

specified within the run control parameters. The report is available in PDF and as a 

query. 

 

FA801 Award Data by Item Type – A report used for reconciliation to review 

student awarded financial aid item types that have disbursed or remain 

undisbursed, displayed by term. The report is available in PDF and as a query. 

 

Fiscal Item Types page – A ctcLink page used in the budgeting of Item Types.  

Assists with reconciliation of FA Item Types. 

 

Reconciliation Queries – A list of available reconciliation queries with directions 

for pulling information and details of data included.   
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Fund Management Processing 
 

Process Process Name Process Description Review Log Required? 
Fund Roster RUN_CNTL_FA920_RPT Pell Origination Y 
FA801 Award Date by 
Item Type 

RUNCTL_FA_RPT_801 COD Pell Outbound 
Orig and Dis 

Y 

Fiscal Item Types page    
Additional Queries   Y 
Reconciliation Queries   Y 
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Running the Fund Roster  
Navigation Description 
Navigation: Financial Aid > Fund 
Management > Fund Roster 
 

Running the Fund Roster using various parameters will 
determine the output.   

 

Enter New or Existing Run Control ID 

Enter the following: 
●​ Institution  

●​ Aid Year 

Please Note – Academic Institution and Aid Year are the only required fields.      

Add additional fields to custom-build the report by Term, Aid Type, Source and/or Item Type 
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Using Schedule Queries 
Navigation Description 
Navigation: Reporting Tools > Query > 
Schedule Queries 

Using Schedule Queries to produce Fund Roster results   

 

Enter New or Existing Run Control ID 

Enter - CTC_FA920, select the Search or Add button 

 

Select the CTC_FA920 link 

 

 

The Edit Prompts pagelet will open 

Insert the User ID and the Run Control name used to run the PDF Fund Roster process from the 

Financial Aid menu. Select the OK button. 
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The Schedule Queries page displays. Ensure that all fields are correct and select the Run button. 
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From the Process Scheduler Request page ensure the PSQUERY box is marked and select OK  

 

Ensure that the process has run to Success and Posted 

 

From the Schedule Queries page select the Report Manger link 

​
 

 

Updated 4/1/2026 Page 8 
 



   Fund Management​  

From the Report List select Fund Roster query #1 

 

Select the CTC_FA920-xxxxxxx.csv link 
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Allow the document to be opened with Excel. (The screen for downloads varies depending on 

which browser is being used.) 

 

Once Excel is open, alter/filter the spreadsheet as needed. 

Use Excel’s AutoSUM function for totals on the Offered, Accepted, Authorized, and Disbursed 

columns. 

Scroll to the bottom of the desired column. Select the field at the very bottom and select the 

AutoSum icon. 
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Running FA801 Award Data by Item Type 
Navigation Description 
Navigation: Financial Aid > Fund 
Management > FA801 Award Data by Item 
Type 
 

Running the FA801 report review to whom each financial 
aid item type was awarded as well as whether the award 
has been disbursed to the student.   

 

Enter New or Existing Run Control ID 

 

Enter the following: 

●​ Institution  

●​ Aid Year 

 

 

 

Select the Run button 

 

 

At the Process Scheduler Request page, select the OK button 
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Once Success and Posted in the Process Monitor, select the Report Manager link 

 

 

 

 

 

 

 

 

 

 

Select the PDF link of the report. 
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This report will generate data for all FA item types where students have an award. This report 

will be very large and in a non-editable PDF format. It will display by item type and EMPLID. 

Updated 4/1/2026 Page 14 
 



   Fund Management​  

​
 

This report can also be run as a query in Schedule Queries.  ​
 

 

 

 

 

 

 

Using Schedule Queries 
Navigation Description 
Navigation: Reporting Tools > Query > 
Schedule Queries 

Using Schedule Queries to produce Fund Roster results   

 

Enter New or Existing Run Control ID 

 

Select the Add or Search button  
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​

 

Enter FA801 in Query Name and select the Search button 

 

Select the FA801 link 

 

​
Enter the edit prompts and select OK 
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​

​
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Select the Run button 

​

 

 

Change the Format drop-down box to XLS and select the OK button 

​
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Once the process is complete in Process Monitor select the Actions link. Next, select the View 

Log/Trace option from the drop-down list. An xlsx link should be available to select and to 

computer. 

The report can also be accessed through Report Manager 

​
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Fiscal Item Types page 
Navigation Description 
Navigation: Set Up SACR > Product Related 
> Financial Aid > Awards > Fiscal Item Types 
 

Viewing Fiscal Item Types page. These pages can be 
reviewed for available funds from which to disburse and 
can also manage annual allocation amounts. 

 

The Fiscal Item Types page can be beneficial when reviewing/reconciling award item types.   

 

 

Budgeted − Offer  
The maximum source of funding that can be offered for this financial aid item type. 

Budgeted − Accept  
The maximum source of funding that can be accepted for this financial aid item type. 

Gross − Offer  
The sum of all gross offered amounts from each student who received this financial aid item type award.  

Gross − Accept  
The sum of all gross accepted amounts from each student who received this financial aid item type 

award.  
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Reductions − Offer   
The sum of the reduced offer amounts from each student for this financial aid item type. If a student is 

offered 800.00 USD for this item type and later the offer is reduced to 600.00 USD, then 200.00 USD is 

added to the sum. If the award is reduced again for the student, then the additional reduction amount is 

added to the sum. 

Reductions − Accept  
The sum of the reduced accept amounts from each student for this financial aid item type.  

Net − Offer 
The sum of the current offer amounts for this financial aid item type. 

Net − Accept   
The sum of the current accept amounts for this financial aid item type. 

Available − Offer   
The remaining source of funding available to award students for this financial aid item type. Equals the 

Budgeted − Offer minus the Net − Offer.  

Available − Accept   
The remaining amount available for students to accept for this financial aid item type. Equals the 

Budgeted − Accept minus the Net − Accept.  

Count − Offer   
The number of students (unduplicated) who have been offered an award of this financial aid item type. 

Does not include students that have canceled or declined awards. 

Count − Accept   

The number of students (unduplicated) who have accepted an award of this financial aid item type. Does 

not include students that have canceled or declined awards. 

Highest − Offer   
The sum of all the highest offer amounts from each student who received this financial aid item type 

award. If a student were initially offered 500.00 USD, then 500.00 USD would be added to this sum. If the 

student was later offered 800.00 USD, then 500.00 USD would be subtracted and 800.00 USD would be 

added to the sum because it is the highest amount offered to the student. This amount displays the 

maximum total offer amount for this financial aid item type. 

Highest − Accept   
The sum of all the highest accepted amounts from each student who received this item type award. This 

amount displays what the maximum total accepted amount is for this financial aid item type. 

Budgeted − Disbursements   
The desired budget amount for the total disbursements of this financial aid item type. 
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Paid − Disbursements   
The amount that has been authorized and disbursed to students from this financial aid item type.  

Potential Payments − Disbursements   
The remaining amount available to disburse to students for this financial aid item type. Equals the 

Budgeted − Disbursements minus the Paid − Disbursements. *Please note – This will include ‘declined’ 

amounts from the student award page.   

Audit Fields 
Select this link to view the Fiscal Item Type Audit page. The Audit Fields link is only available for the 

current aid year. Once the aid year rollover takes place it will only be visible for that aid year.  

Example – Once 2026/2027 aid year rollover occurs the Audit Fields link will not be available on the 

2025/2026 Fiscal Item Types page.   

NOTE: When two users at a college disburses the same Item Type for the same student at the same time, 

the Net amount row and the Paid row may get out of sync (see arrows in image below). Take caution to 

ensure manual disbursements are not made while batch disbursements are running. 
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Fiscal Fund Status 

 

Cancelled Amount  
Displays the sum of the awards of this financial aid item type that have been cancelled. 

Cancelled Count  
Displays the number of students that have cancelled awards of this financial aid item type. 

Declined Amount  
Displays the sum of the awards of this financial aid item type that have been declined. 

Declined Count  
Displays the number of students that have declined awards of this financial aid item type. 

 

 

Updated 4/1/2026 Page 24 
 



   Fund Management​  

Fiscal Fund Notes 
Example of notes that can be created for user review. 
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Reconciliation Queries 
There are several queries available to help in reconciling financial aid. At the end of this document there 

is a list of additional fund management and reconciliation queries. 

 

CTC_FA_SF_DISCREPANCY_LIST 
The example below shows how to run the query for CTC_FA_SF_DISCREPANCY_LIST and the results. 

Each query will have its own set of edit prompts.   

Go to the Schedule Queries page. Enter the query name and select Search. 

 

Select the blue link of the query name. 

 

The Edit Prompts pagelet will appear. Enter the desired values for the edit prompts and select the OK 

button. 
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 Select the Run button  
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Ensure the PSQUERY box is checked and select the OK button. 

 

Select the Process Monitor link 
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Once status is set to Success and Posted select the Actions link and then select the View Log/Trace 

option. 

 

 

Select the CTC_FA_SF_DISCREPANY_LIST-xxxxxx.csv link. It can also be accessed from Report Manager 

 

A pop up message displays confirming options to open or save in Microsoft Excel.  
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Once file is opened, the results will be as displayed below. Columns can be hidden and sorted as 

necessary. 

 

There are numerous reasons as to why there are discrepancies between Financial Aid and Student 

Financials. Common examples would be book amounts there were not fully spent. Tuition Waivers where 

tuition was less than the amounts awarded. Or a refund amount from Student Financials (dropped 

classes, R2T4, etc) where there is a no-refund service indicator and the amounts have yet to be reduced 

in the award page. 

 

 

 

 

Running one of the following queries may help in investigating why the amounts 

are unapplied: 

QCS_SF_CREDIT_BAL_NONREF - Identifies students with a credit balance from nonrefundable item types 

for the colleges to fix as part of their monthly reconciliation. 

QCS_SF_ITM_TYPE_GL_INTERFACE – Lists item-type set up including charge priority, payment priority, 

etc. 
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CTC_FA_DISBURSED_BY_DATE_UNITS 
The example below shows how to run the query for CTC_FA_DISBURSED_BY_DATE_UNITS and the 

results.   

 

This query is prompted by Institution, Aid Year, and Disbursement Date. 

 

This query can be after the Authorization and Disbursement process has run and before the refund 

process has been run in Student Financials. It will show what awards were in the group post that has 

been sent over to Student Financials. This can be viewed to make sure amounts of the awards match the 

units the student is enrolled in. 
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​
​
 

QCS_SF_FA_SA_APPLIED_SUMMARY 
The example below shows how to run the query for QCS_SF_FA_SA_APPLIED_SUMMARY and the 

results. 

 

This query is prompted by Institution, SetID and either ALL item types or a RANGE of item types. 
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These results will show a summary of the total amount of the awards that were posted in customer 

accounts. This report should after clearing up the issues on the discrepancy report. 

 

QCS_SF_FA_SA_APPLIED_DETAILS 
The example below shows how to run the query for QCS_SF_FA_SA_APPLIED_DETAILS and the results. 

 

These prompts are the same values as the summary query in addition to an added Term prompt. 
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The results of this query show the detail of what charges the award paid in Student Financials. The 

example is one student. 

 

Fund Management/Reconciliation Queries 

Query Name Definition 
CTC_FA_ITEM_DISBURSED Annual sum of what has been disbursed in each FA 

item type for year prompted 
CTC_FA_CBS_AND_SNG_LIST List of CBS students and their SNG amounts should 

they have them.  Per term 
CTC_FA_WAITLISTED_AWARDS Identifies students who have been awarded a 

waitlisted item type not in Cancelled status. 
Colleges can use this list to award students on 
first-come-first-serve basis when funds become 
available at a later date 

CTC_FA_TERM_ITEM_TYPE_AWARDED List of students who have been awarded prompted 
item types per term 

CTC_FA_THIRD_PARTY_PYMNTS Lists of students with a valid ISIR, by term that are 
receiving waivers, Agency Funding or Third-Party 
Contracts so that the Financial Aid Staff can manage 
the students’ educational resources which may 
affect their eligibility for other FA awards. 

CTC_FA_SF_DISCREPANCY_LIST Identifies students who have aid disbursed but a 
portion or all is unapplied on Customer Accounts. 

QCS_SF_FA_SA_APPLIED_DETAILS Renamed CTC_SF_FINAID_REFUND_DETAILS since 
the query name is misleading. Results show 
item-types and what it applied to including refunds. 
Run CTC_FA_SF_DISCREPANCY_LIST to find 
item-types with unapplied amounts. 

QCS_SF_FA_SA_APPLIED_SUMMARY Renamed CTC_SF_FINAID_REFUND_SUMMARY 
since the query name is misleading. Results show 
item-types and amount applied to Customer 
Accounts. Run CTC_FA_SF_DISCREPANCY_LIST to 
find item-types with unapplied amounts. 

QCS_FA_GRP_PAY Select a Student Group to see the funds that have 
disbursed for them and what they applied to 
including refunds. 

CTC_FA_DISBURSED_BY_DATE_UNITS List of students who had aid disbursed.  Prompted 
by Institution, aid year, and disbursement date 
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CTC_FA_OVERAWARDED Lists students who have been awarded over their 
annual COA 

CTC_FA_TERM_OVERAWARDED Lists students who have been awarded over their 
term COA 
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